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All information included in this document is current as of the date this document is issued. Such information, however, is
subject to change without any prior notice. Before purchasing or using any Renesas Electronics products listed herein, please
confirm the latest product information with a Renesas Electronics sales office. Also, please pay regular and careful attention to
additional and different information to be disclosed by Renesas Electronics such as that disclosed through our website.
Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights
of third parties by or arising from the use of Renesas Electronics products or technical information described in this document.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights
of Renesas Electronics or others.
You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part.
Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of
semiconductor products and application examples. You are fully responsible for the incorporation of these circuits, software,
and information in the design of your equipment. Renesas Electronics assumes no responsibility for any losses incurred by
you or third parties arising from the use of these circuits, software, or information.
When exporting the products or technology described in this document, you should comply with the applicable export control
laws and regulations and follow the procedures required by such laws and regulations. You should not use Renesas
Electronics products or the technology described in this document for any purpose relating to military applications or use by
the military, including but not limited to the development of weapons of mass destruction. Renesas Electronics products and
technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited
under any applicable domestic or foreign laws or regulations.
Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics
does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever for any damages
incurred by you resulting from errors in or omissions from the information included herein.
Renesas Electronics products are classified according to the following three quality grades: “Standard”, “High Quality”, and
“Specific”. The recommended applications for each Renesas Electronics product depends on the product’s quality grade, as
indicated below. You must check the quality grade of each Renesas Electronics product before using it in a particular
application. You may not use any Renesas Electronics product for any application categorized as “Specific” without the prior
written consent of Renesas Electronics. Further, you may not use any Renesas Electronics product for any application for
which it is not intended without the prior written consent of Renesas Electronics. Renesas Electronics shall not be in any way
liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for an
application categorized as “Specific” or for which the product is not intended where you have failed to obtain the prior written
consent of Renesas Electronics. The quality grade of each Renesas Electronics product is “Standard” unless otherwise
expressly specified in a Renesas Electronics data sheets or data books, etc.
“Standard”:
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11.
12.

Computers; office equipment; communications equipment; test and measurement equipment; audio and visual
equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots.
“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anticrime systems; safety equipment; and medical equipment not specifically designed for life support.
“Specific”:
Aircraft; aerospace equipment; submersible repeaters; nuclear reactor control systems; medical equipment or
systems for life support (e.g. artificial life support devices or systems), surgical implantations, or healthcare
intervention (e.g. excision, etc.), and any other applications or purposes that pose a direct threat to human life.
You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics,
especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation
characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or
damages arising out of the use of Renesas Electronics products beyond such specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have
specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further,
Renesas Electronics products are not subject to radiation resistance design. Please be sure to implement safety measures to
guard them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a
Renesas Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire
control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because
the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or system
manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental
compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all applicable
laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS
Directive. Renesas Electronics assumes no liability for damages or losses occurring as a result of your noncompliance with
applicable laws and regulations.
This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written consent of Renesas
Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this
document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its majorityowned subsidiaries.
(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.
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1.

Preface

This document explains the High-performance Embedded Workshop (herein as Renesas IDE) simulator functionality
shown in Table 1-1.
Table 1-1 List of functionality explained in this document
Functionality
Simulated I/O
Image display
Profiler
Performance analysis
Pseudo-interrupts
Timer simulation
Eventpoints
Virtual I/O panels

Chapter with explanation
Chapter 2
Chapter 3
Chapter 4
Chapter 4
Chapter 5
Chapter 6
Chapter 7
Chapter 8

Each type of functionality comes with sample projects, which are provided from the download site with this document.
SH-2A and SH-4 sample projects are provided for pseudo-interrupts. For functionality other than pseudo-interrupts, only
SH-2A sample projects are provided. Table 1-2 shows the project name for each sample project. Make sure that you place
the sample project workspace in C:\WorkSpace\sample.
Table 1-2 Sample projects explained in this document
Contents
Simulated I/O
Image display
Profiler / performance analysis
Pseudo-interrupts (for SH-2A)
Pseudo-interrupts (for SH-4)
Timer simulation
Eventpoints
Virtual I/O panel

Project name
sample_file_io
sample_img
sample_profile
sample_trigger_sh2a
sample_trigger_sh4
sample_timer
sample_ep
sample_panel

For details about the sample projects, see the sample program explanations given in each chapter. Make sure that sample
projects are created on the following environment, as sample projects cannot be opened on earlier environments. Note
that these sample projects are for simulator use. Sample programs for simulated I/O will not run on an emulator.
•
•
•
•

… V.9.01 Release 01
… V.4.03.00
… V.9.1.1.0
… V.9.0.7

Renesas SuperH Family C/C++ Compiler Package
High-performance Embedded Workshop
Toolchain
Simulator
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2.
2.1

Simulated I/O
Overview

The simulator comes with simulated I/O functionality to virtually check files and standard I/O in the simulator. This
chapter gives an overview of simulated I/O functionality, and explains sample programs that use this functionality to
check files and standard I/O.
(1)

Low-level Interface Routine

When C/C++ is used to develop programs, the standard I/O library (fopen(), printf(), scanf(), and other
functions) is often used to perform file and standard I/O. In such cases, the standard I/O library calls the
user-implemented functions actually performing I/O to perform file and standard I/O. The functions that actually perform
I/O are called Low-level Interface Routines. These Low-level Interface Routines are needed because embedded
applications have a variety of I/O destinations for standard I/O, including LCDs, hard disks, printers, CD-R/RW drives,
DIP switches, keyboards, mice, mobile phone buttons, and touch panels, and each of these requires its own I/O processing
applied to the user system. As such, the standard I/O library is comprised of a group of user-defined functions called
low-level interface routines.
Low-level interface routines are implemented according to the specification in SuperHTM RISC engine C/C++ Compiler,
Assembler, Optimizing Linkage Editor User's Manual 9.2.2 Execution Environment Settings (6) Low-level interface
routines. This chapter introduces sample programs for the low-level interface routines for virtually performing file and
standard I/O in a simulator. These sample programs correspond to standard input (stdin), standard output (stdout),
standard error output (stderr), and file I/O.
(2)

Simulated I/O functionality

Functionality to virtually perform file and standard I/O in a simulator is called simulated I/O functionality. Simulated I/O
functionality is executed using branch instructions to a specific address (simulated I/O address) set in the simulator.
Branch instructions to simulated I/O addresses are only called by simulated I/O functionality, as branching itself is not
performed. Parameters for simulated I/O functionality are passed using the R0 register and R1 register. The simulated I/O
functionality used (function code) is set in the R0 register. The simulator performs file I/O and string output to the
simulator windows according to the function code set in the R0 register. The start address of the memory area (parameter
block) in which file names, output characters, and other parameters specific to simulated I/O functionality are set is set in
the R1 register. For details about how to set simulated I/O function codes and parameter blocks, see 2.2 Functionality.
When simulated I/O functionality is called (a branch instruction is executed) as shown above, parameters need to be set in
R0 and R1. As such, the parts of simulated I/O functionality called (simulated I/O functions) need to be coded in
assembly language. The sample programs call simulated I/O function from low-level interface routines, so that file and
standard I/O can be performed in the simulator.
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User program

Standard library function
Low-level interface routines are called.

Low-level interface routine
Simulated I/O functions are called.

Simulated I/O functions (example)
_i_o_simulation:
Simulated I/O functions
The function code is set in R0 and the start
address of the parameter is set in R1.
Simulated I/O functions are called in branch
instructions to simulated I/O.

; Simulated I/O function

MOV

R4,R0

; Setting the function code in R0

MOV

R5,R1

; Setting the start address of the parameter block in R1

MOV
JSR
NOP
RTS
NOP

#H’0,R2 ; Branch instruction to the simulated I/O address
@R2
; The call is returned.

Simulated I/O functions
I/O to the Simulated I/O window

Key input in the window is handled as
standard input passed to simulated I/O
functions.

Standard output and standard error output from
simulated I/O functions is displayed in the window.

Figure 2-1
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2.2

Functionality

The function code needs to be set in the R0 register, and the parameter block start address needs to be set in the R1 register,
before simulated I/O functionality is called. Figure 2-2 shows the contents set in the R0 register and R1 register. When
I/O processing is finished, simulation is restarted from the next instruction of the branch instructions to the simulated I/O
address.
Function code (R0 register)
0x01
MSB
1 byte

Function code
(See Table 2-1)

---

---

LSB

1 byte

1 byte

1 byte

Start address of the parameter block (R1 register)
MSB

LSB
Memory

Set start address

Parameter block
(data storage area)

Figure 2-2
Table 2-1 shows the functionality supported by simulated I/O.
Table 2-1 List functionality
No.
1
2
3
4
5
6
7
8
9
10
11
12
13

Function Code
H'21
H'22
H'23
H'24
H'25
H'06
H'27
H'28
H'29
H'2A
H'0B
H'0C
H'0D

Function Name
GETC
PUTC
GETS
PUTS
FOPEN
FCLOSE
FGETC
FPUTC
FGETS
FPUTS
FEOF
FSEEK
FTELL

Description
Inputs one byte from the standard input device
Outputs one byte to the standard output device
Inputs one line from the standard input device
Outputs one line to the standard output device
Opens a file
Closes a file
Inputs one byte from a file
Outputs one byte to a file
Inputs one line from a file
Outputs one line to a file
Checks for end of the file
Moves the file pointer
Returns the current position of the file pointer

The following explains each kind of I/O functionality.
(1) Number shown in Table 2-1
(5) I/O parameter block
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(6) I/O parameters
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GETC: Inputs one byte from the standard input device
1

GETC

Inputs one byte from the standard input device

H’21
1 byte
+0
+2

1 byte

Input buffer start address

• Input buffer start address (input)
Start address of the buffer in which the output data is
stored.

PUTC: Outputs one byte to the standard output device
2

PUTC

Outputs one byte to the standard output device

H’22
1 byte
+0
+2

1 byte

Output buffer start address

• Output buffer start address (input)
Start address of the buffer in which the output data is
stored.

GETS: Inputs one line from the standard input device
3

GETS

Inputs one line from the standard input device

H’23
1 byte
+0
+2

1 byte
Input buffer start address

• Input buffer start address (input)
Start address of the buffer in which the output data is
stored.

PUTS: Outputs one line to the standard output device
4

PUTS

Outputs one line to the standard output device

H’24
1 byte
+0
+2

1 byte

Output buffer start address

REJ06J0045-0100/Rev.1.00

• Output buffer start address (input)
Start address of the buffer in which the output data is
stored.
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FOPEN: Opens a file
FOPEN

5

Opens a file

H’25

The [FOPEN] opens a file and returns the file
number. After this processing, the returned file
number must be used to input, output, or close
files. A maximum of 256 files can be open at the
same time.
1 byte
+0
+2
+4
+6

1 byte

Return value
Open mode

File number
Unused

Start address of file name

• Return value (output)
0
Normal completion
-1 Error
• File number (output)
The number to be used in all file accesses after
opening.
• Open mode (input)
H'00 "r"
H'01 "w"
H'02 "a"
H'03 "r+"
H'04 "w+"
H'05 "a+"
H'10 "rb"
H'11 "wb"
H'12 "ab"
H'13 "r+b"
H'14 "w+b"
H'15 "a+b"
These modes are interpreted as follows.
"r"
Open for reading.
"w"
Open an empty file for writing.
"a"
Open for appending (write starting at the end of
the file).
"r+" Open for reading and writing.
"w+" Open an empty file for reading and writing.
"a+" Open for reading and appending.
"b"
Open in binary mode.
• Start address of file name (input)
The start address of the area for storing the file name.

FCLOSE: Closes a file
FCLOSE

6

Closes a file

H’06
1 byte
+0

Return value

1 byte
File number
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• Return value (output)
0 Normal completion
-1 Error
• File number (input)
The number returned when the file was opened.
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FGETC: Inputs one byte from a file
7

FGETC

Inputs one byte from a file

H’27
1 byte
+0
+2
+4
+6

1 byte

Return value
File number
Unused
Input buffer start address

• Return value (output)
0
Normal completion
-1 Error
• File number (input)
The number returned when the file was opened.
• Input buffer start address (input)
Start address of the buffer in which the output data is
stored.

FPUTC: Outputs one byte to a file
8

FPUTC

Outputs one byte to a file

H’28
1 byte
+0
+2
+4
+6

1 byte

Return value
File number
Unused
Output buffer start address

• Return value (output)
0
Normal completion
-1 Error
• File number (input)
The number returned when the file was opened.
• Output buffer start address (input)
Start address of the buffer in which the output data is
stored.

FGETS: Inputs one line from a file
9

FGETS

Inputs one line from a file

H’29

Reads character string data from a file. Data is
read until either a new line code or a NULL code
is read, or until the buffer is full.
1 byte
+0
+2
+4
+6

1 byte

Return value
File number
Buffer size
Input buffer start address
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• Return value (output)
0
Normal completion
-1 Error
• File number (input)
The number returned when the file was opened.
• Buffer size (input)
The size of the area for storing the read data.
A maximum of 256 bytes can be stored.
• Input buffer start address (input)
Start address of the buffer in which the output data is
stored.
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FPUTS: Outputs one line to a file
FPUTS

10

Outputs one line to a file

H’2A

Writes character string data to a file. The NULL
code that terminates the character string is not
written to the file.
1 byte
+0
+2
+4
+6

1 byte

File number
Return value
Unused
Output buffer start address

• Return value (output)
0
Normal completion
-1 Error
• File number (input)
The number returned when the file was opened.
• Output buffer start address (input)
Start address of the buffer in which the output data is
stored.

FEOF: Checks for end of the file
FEOF

11

Checks for end of the file

H’0B
1 byte
+0

Return value

1 byte
File number

• Return value (output)
0 File pointer is not at EOF
-1 EOF detected
• File number (input)
The number returned when the file was opened.

FSEEK: Moves the file pointer
12

FSEEK

Moves the file pointer

H’0C
1 byte
+0
+2
+4
+6

Return value
Direction

1 byte
File number
Unused
Offset
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• Return value (output)
0
Normal completion
-1 Error
• File number (input)
The number returned when the file was opened.
• Direction (input)
0
The offset specifies the position as a byte count
from the start of the file.
1
The offset specifies the position as a byte count
from the current file pointer.
2
The offset specifies the position as a byte count
from the end of the file.
• Offset (input)
The byte count from the location specified by the
direction parameter.
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FTELL: Returns the current position of the file pointer
13

FTELL

Returns the current position of the file pointer

H’0D
1 byte
+0
+2
+4
+6

1 byte

File number
Return value
Unused
Offset
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• Return value (output)
0
Normal completion
-1 Error
• File number (input)
The number returned when the file was opened.
• Offset (output)
The current position of the file pointer, as a byte count
from the start of the file.
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2.3

Usage

To use simulated I/O, first enable simulated I/O functionality. Note that the Simulated I/O window needs to be displayed
to check standard I/O.
(1)

Enabling simulated I/O

To enable simulated I/O, from Simulator in the Setup menu, choose System to display the Simulator System dialog box.
In the Simulator System dialog box, select the Enable checkbox and set the simulated I/O address.

Figure 2-3
Simulated I/O functionality will not operate if Simulated I/O Address in the Simulator System dialog box and the
simulated I/O address in the program do not match. For example, assume the simulated I/O address in the attached sample
program is H'00000000. For an SH-4/SH-4A CPU, the simulated I/O address is H'00000004 by default. This means that
if the sample program is used with SH-4/SH-4A, Simulated I/O Address needs to be changed in the Simulator System
dialog box, or the simulated I/O address must be changed in the program.
(2)

Displaying the simulated I/O window

To use simulated I/O, the Simulated I/O window must also be displayed. From CPU in the View menu, choose
Simulated I/O to display simulated I/O. Note that the Simulated I/O window must also be displayed when file I/O is
used.

Figure 2-4
(3)

Using the Simulated I/O window

When a low-level interface routine is implemented using simulated I/O, standard output from the application program is
output to this window. Likewise, key input in this window is the standard input to the application program.

REJ06J0045-0100/Rev.1.00

April.2008

Page 11 of 56

APPLICATION NOTE

Key input in the window is handled as
standard input passed to simulated I/O
functions.

Standard output and standard
error output from simulated I/O
functions is displayed in the
window.

Figure 2-5

2.4

Sample program

lowsrc.src and lowsrc.c are implemented in the sample program so that file and standard I/O can be checked in
simulated I/O. lowsrc.c implements the low-level interface routines used by the standard library functions: open(),
close(), read(), write(), and lseek(). Note that with lowsrc.src, simulated I/O functions are
implemented as called from low-level interface routines.

2.4.1
(1)

Source files

lowsrc.src

Simulated I/O functions need to be coded in the assembler. The simulated I/O function i_o_simulation is defined in
lowsrc.src. This simulated I/O function is used by the low-level interface routines open(), close(), read(),
write(), and lseek() to call simulated I/O functionality.
The following processing is performed before i_o_simulation calls simulated I/O functionality:
• The function code specified in the first argument is set in R0.
• The parameter block address specified in the second argument is set in R1.
(2)

lowsrc.c

The low-level interface routines open(), close(), read(), write(), and lseek(), as well as the standard
library initialization programs _INIT_IOLIB() and _CLOSEALL() are implemented in lowsrc.c.
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Table 2-2 Functions defined in lowsrc.src
Functionality

Function
name
open

Opening files

close

Closing files

read

Inputting data

write

Outputting data

lseek

Moving a file
pointer to the
specified location

_INIT_IOLI Performing initial
B
standard I/O
settings
_CLOSEALL Closing all files

Processing
This calls the i_o_simulation function with the FOPEN function code
specified. If stdin is specified, the specified open mode is ignored, and
the file is opened as read-only. If anything other than stdin is
specified, the file is opened according to the open mode.
This calls the i_o_simulation function with the FCLOSE function
code specified, and closes the file.
If stdin is specified, this calls the i_o_simulation function with the
GETC function code specified, and loads input from the standard input. If
anything other than stdin is specified, the i_o_simulation function
is called with the FGETC function code specified, and the string is read
from the specified file.
When stdout/stderr is specified, the i_o_simulation function is
called with the PUTC function code specified, and the specified string is
output to the standard output. If anything other than stdout/stderr is
specified, the i_o_simulation function is specified with the FPUTC
function code specified, and the string is output to the specified file.
This calls the i_o_simulation function with the FSEEK function code
specified, and moves the file pointer to the specified location. It then
calls the i_o_simulation function with the FTELL function code
specified, to obtain the current offset value.
This opens stdin/stdout/stderr.

This closes all open files (including stdin/stdout/stderr).

Note In the sample program, the _CLOSEALL() function is called when main() terminates, and processing
is performed to close all files. During program execution, when execution is performed after reset but
before close processing is called, since the _CLOSEALL() function has not been called, operation may
not be performed as expected. When using the _INIT_IOLIB() and open() functions, execute them
after calling the _CLOSEALL() function, and after reset. To reset the debugger without executing the
_CLOSEALL() function, from the File menu, choose Refresh Session.
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2.4.2

Main processing

The main function of the sample program uses the scanf() function to load the string input to the standard input, and
then uses the printf() function to output the loaded string to the standard output. It then uses the fopen() function,
to open the C:\WorkSpace\sample\file.txt file, and uses the fscanf() function to load the string from the
file, and uses the printf() function to output the loaded string to the standard output.
#include <stdio.h>
unsigned char buf[100];
void main (void)
{
FILE* fp;
scanf ("%s", buf);
printf ("Input=%s\n", buf);
fp = fopen
if ( fp !=
fscanf
printf
fclose
}

("C:\\WorkSpace\\sample\\file.txt", "r");
NULL ) {
(fp, "%s", buf);
("File=%s\n", buf);
(fp);

}

The scanf(), printf(), fopen(), fscanf(), and fclose() functions in the standard library call each of the
following low-level interface routines:
•
•
•
•
•

scanf():
printf():
fopen():
fscanf():
fclose():

Calls the read() function for the standard input (stdin).
Calls the write() function for the standard output (stdout).
Calls the open() function for the specified file for fopen().
Calls the read() function for the specified file for fscanf().
Calls the close() function for the specified file pointer for fclose().
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Strings entered in the Simulated I/O window are used as
standard input, and loaded by the scanf() function.

Standard output is output by the printf() function, and
displayed in the Simulated I/O window.

Strings entered from files via the fscanf() function are
output to standard output by the printf() function, and
displayed in the Simulated I/O window.

C:\WorkSpace\sample\file.txt
Message!

Figure 2-6
Note

When checking file I/O for simulated I/O, use an absolute path to specify the file name specified for file
open (fopen()). Make sure that \\, not \, is specified as the separator in the absolute path.
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3.
3.1

Image display
Overview

Image display functionality can be used to visually confirm the contents of image data during program execution. From
Graphic in the View menu, choose Image to display the Image Properties dialog box.

Figure 3-1
In the Image Properties dialog box, when the buffer address and size are specified in Buffer Information, and the format
of image data in the buffer is specified in Color Information, image data is displayed in the Image window during
program execution. The following chapter explains the image formats that can be displayed.

Figure 3-2
To update the images during program execution in real-time, right-click the Image window to display the pop-up menu,
and then from Auto Refresh, choose Real time.
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Figure 3-3
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3.2

Supported image formats

The following image formats can be selected from the Image Properties.
Table 3-1 List of image formats - Monochrome/RGB/BGR
Color information
Mode
Bits/pixel
Monochrome
–
RGB/BGR

8 bits
(Index
Color)

Data

Data image

One bit per pixel
Bit data - 1: white, 0: black
A 256-color (RGB/BGR
represented in 32 bits) palette is
used, in which image data is
stored as numbers (0 to 255)
referencing the palette table.
The pixel data from the palette
table is represented in Blue: 8
Green: 8 Red: 8 alpha: 8-bit.

Bit data: B’10100000
Pixel data: H’05
This references the sixth color from the
palette table.
The sixth pixel data from the palette table is
H'E7 H'C3 H'81 H'00
BGR: Blue: 231 Green: 195 Red: 129 Alpha:
0
231

16 bits
(5:5:5)

Image display functionality
ignores the value of alpha for
transparency information.
RGB: Red: 5 Green: 5 Blue: 5
BGR: Blue: 5 Green: 5 Red: 5
The highest bit is padding.

195

129

---

Pixel data H’4677 (=B'0100011001110111)
RGB: Red: 17 Green: 19 Blue: 23
17

19

23

BGR: Blue: 17 Green: 19 Red: 23
17

16 bits
(5:6:5)

23

RGB: Red: 5 Green: 6 Blue: 5-bit Pixel data H’8A77 (=B'1000101001110111)
BGR: Blue: 5 Green: 6 Red: 5-bit RGB: Red: 17 Green: 19 Blue: 23
17

The highest bit for green is
padding.

19

23

BGR: Blue: 17 Green: 19 Red: 23
17

24 bits

19

19

23

RGB: Red: 8 Green: 8 Blue: 8-bit Pixel data H’81 H’C3 H’E7
BGR: Blue: 8 Green: 8 Red: 8-bit RGB: Red: 129 Green: 195 Blue: 231
129

195

231

BGR: Blue: 129 Green: 195 Red: 231
129

32 bits

195

231

RGB: Alpha: 8 Red: 8 Green: 8
Blue: 8-bit
BGR: Alpha: 8 Blue: 8 Green: 8
Red: 8-bit

Pixel data H’00 H’81 H’C3 H’E7
RGB: Alpha: 0 Red: 129 Green: 195 Blue:
231

Image display functionality
ignores the value of alpha for
transparency information.

BGR: Alpha: 0 Blue: 129 Green: 195 Red:
231
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Table 3-2 List of image formats (2) - YCbCr
Color information
Mode
Sampling
ratio
YCbCr
4:4:4

Data
Source data Sampling data
11,12,13,14
21,22,23,24
31,32,33,34
41,42,43,44

11,12,13,14
21,22,23,24
31,32,33,34
41,42,43,44

Data image

chunky
Y11,Cb11,Cr11,Y12,Cb12,Cr12,Y13,Cb13,Cr13,
...,Ynm,Cbnm,Crrnm
planar
Y11,Y12,Y13,...,Ynm,Cb11,Cb12,Cb13,...,Cbnm,
Cr11,Cr12,Cr13,...,Crnm

4:2:2

11,12,13,14
21,22,23,24
31,32,33,34
41,42,43,44

11,11,13,13
21,21,23,23
31,31,33,33
41,41,43,43

planar2
Y11,Y12,Y13,...,Ynm,
Cb11,Cr11,Cb12,Cr12,Cb13,Cr13,...,Cbnm,Crnm
chunky
Y11,Y12,Cb11,Cr11,Y13,Y14,Cb13,Cr13,
...,Yn (m-1),Ynm,Cbn (m-1),Crn (m-1)
planar
Y11,Y12,Y13,...,Ynm,Cb11,Cb13,Cb15,...,Cbn (m-1),
Cr11,Cr13,Cr15,...,Crn (m-1)

4:1:1

11,12,13,14
21,22,23,24
31,32,33,34
41,42,43,44

11,11,11,11
21,21,21,21
31,31,31,31
41,41,41,41

planar2
Y11,Y12,Y13,...,Ynm,
Cb11,Cr11,Cb13,Cr13,Cb15,Cr15,...,Cbn (m-1),Crn (m-1)
chunky
Y11,Y12,Y13,Y14,Cb11,Cr11,
Y21,Y22,Y23,Y24,Cb23,Cr21,
...,Yn (m-3),Yn (m-2),Yn (m-1),Ynm,Cbn (m-3),Crn (m-3)
planar
Y11,Y12,Y13,...,Ynm,Cb11,Cb13,Cb15,...,Cbn (m-1),
Cr11,Cr13,Cr15,...,Crn (m-1)

4:2:0

11,12,13,14
21,22,23,24
31,32,33,34
41,42,43,44

11,11,13,13
11,11,13,13
31,31,33,33
31,31,33,33

planar2
Y11,Y12,Y13,...,Ynm,
Cb11,Cr11,Cb13,Cr13,Cb15,Cr15,...,Cbn (m-1),Crn (m-1)
planar
Y11,Y12,Y13,,..., Ynm,
Cb11,Cb13,Cb15,...,Cbn (m-1),
Cr11,Cr13,Cr15,...,Crn (m-1)
planar2
Y11,Y12,Y13, ,...,Ynm,
Cb11,Cr11,Cb13,Cr13,Cb15,Cr15,...,Cbn (m-1),Crn (m-1)
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3.3

Sample program

In the sample program, the two pieces of image data, data0 and data1, are alternately copied to the buffer buf. The
image data used is in a 200x200-pixel, 24-bit RGB format.
#define SIZE (120000)
extern const unsigned char data0[SIZE]; /* Image Data0 */
extern const unsigned char data1[SIZE]; /* Image Data1 */
unsigned char buf[SIZE]; /* Buffer */
void main (void)
{
int i;
for (;;)
{
for (i=0; i < SIZE; i++ )
buf[i] = data0[i]; /*
}
for (i=0; i < SIZE; i++ )
buf[i] = data1[i]; /*
}
}

{
Image Data0 */
{
Image Data1 */

}

From Graphic in the View menu, choose Image to display the Image Properties dialog box, and perform the following
settings:
• Color Information
⎯ For Mode, choose RGB
⎯ From the Bit/Pixel drop-down list, choose 24 bits
• Buffer Information
⎯ Click the button to the right of the Data Address field to display the Select Label dialog box, and then select _buf
⎯ For Width/ Height Size (Pixel), enter 200 in decimal for both Width and Height
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Figure 3-4
The image is displayed in the Image window. To have the image update in real-time, right-click the Image window to
display the pop-up menu, and in Auto Refresh, choose Real time. Swapping between the two image data can be seen.

Figure 3-5
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4.

Profiler

4.1

Overview

The simulator comes with profiler functionality and performance analysis functionality to measure the execution
performance of application programs. The following lists characteristics of profiler functionality and performance
analysis functionality.
Table 4-1 Characteristics of profiler functionality and performance analysis functionality
Item
Measurement coverage
Obtainable execution
performance items
Child function measurement
Simulation speed
(1)

Profiler functionality

Performance analysis
functionality
Specific functions
Few

All functions
Many

Not possible
Fast

Possible
Slow

Performance analysis functionality

Performance analysis functionality measures the following items for specific functions in an application program:
•
•
•
•

Execution cycle count
Call count
Ratio of execution cycle count for the corresponding function as a ratio of program-wide execution cycle count
Histogram of above ratio

Since only specific functions are measured, faster simulations are possible compared to profiling. Use this when
measuring large-scale applications that require significant time to simulate.
Note that measurement is not performed for child functions. To measure a child function, include the child function as
part of the measurement target for performance analysis.
(2)

Profiler functionality

Profiler functionality measures various execution performance items for all functions in an application program. It can be
used for detailed analysis of area and causes of performance degradation with an application program, as well as
displaying execution results, including those for child functions.
For details about the execution performance items that can be obtained, see SuperHTM RISC engine Simulator/Debugger
User's Manual 3.6.10 Types and Purposes of Displayed Data.
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4.2

Usage

The following explains how to use performance analysis functionality and profiler functionality.
(1)

Performance analysis functionality

From Performance in the View menu, choose Performance Analysis to display the Performance Analysis window. In
the Performance Analysis window, right-click to display the pop-up menu, and then choose Add Range to display the
Performance Option dialog box. In the Performance Option dialog box, specify the name of the function to be measured.
Then, from the same pop-up menu, choose Enable Analysis (a check mark will be displayed in the pop-up menu).

Figure 4-1
When the program is executed, the specified function is measured. The following figure shows the measurement results.

Figure 4-2
The items displayed are as follows:
Index

Index number of the set condition

Function

Name (or start address) of the measured function

Cycle

Cumulative execution cycle count for the corresponding function

Count

Cumulative call count for the corresponding function

%
count

Execution cycle count for the corresponding function, as a ratio of the program-wide execution cycle

Histogram

Histogram display of the above ratio
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(2)

Profiler functionality

From Performance in the View menu, choose Profile to display the Profiling window. Right-click in the Profiling
window to display the pop-up menu, and choose Enable Profiler (a check mark will be displayed in the pop-up menu).
To include child functions in the displayed execution results, from Setting in the pop-up menu, choose Include Data of
Child Functions (a check mark will be displayed in the pop-up menu).

Figure 4-3
The program is executed, and the function and variable information is obtained. The function execution count or variable
access count is displayed for Times, and the execution cycle count is displayed for Cycle. For details about other items
displayed, see SuperHTM RISC engine Simulator/Debugger User's Manual 3.6.10 Types and Purposes of Displayed Data.
The Profiling window contains a List sheet and a Tree sheet, as shown in the following figure.
• List
⎯ The measurement results are displayed in a list.

Figure 4-4

REJ06J0045-0100/Rev.1.00

April.2008

Page 24 of 56

APPLICATION NOTE
• Tree
⎯ The Function column displays the measurement results in tree format.
Double-click the Function column to expand or hide the tree structure.

Figure 4-5
The measurement results in the Profiling window can be used to display the call relationship for functions according to a
specific function.
Select a function as shown in Figure 4-4 or Figure 4-5, and right-click it to display a pop-up menu. From the pop-up menu,
choose View Profile-Chart to display the Profile-Chart window.
The chosen function is displayed in the center of the Profile-Chart window, with the function from which it was called on
the right, and the functions it called on the left. Note that the number of times each function is called is also displayed.

Figure 4-6

REJ06J0045-0100/Rev.1.00

April.2008

Page 25 of 56

APPLICATION NOTE
4.3

Sample program

The following shows examples of performance measurement using performance analysis functionality and profiler
functionality, which in turn uses the three types of sort programs provided as sample programs (quicksort:
quicksort(), heapsort: heapsort(), and bubblesort: bubblesort()).
Note that the order of unbiased efficiency for sorted data is: quicksort > heapsort > bubblesort.
• Main processing
#include <string.h>
extern void quicksort (int n, int a[]);
extern void bubblesort (int n, int a[]);
extern void heapsort (int n, int a[]);
#define N (80)
const int array[N] = {
0, 690, 505, 591, 554,
843, 68, 409, 879, 319,
507, 872, 333, 692, 556,
449, 432, 606, 927, 664,
307, 596, 783, 338, 805,
545, 864, 457, 800, 873,
462,
7, 635, 421, 953,
707, 285, 318, 643, 858,
};

378,
980,
361,
395,
942,
821,
210,
668,

257,
85,
31,
438,
66,
185,
970,
443,

207,
907,
858,
652,
857,
86,
261,
55,

626,
102,
98,
928,
977,
638,
857,
777,

340,
921,
877,
949,
889,
233,
581,
594,

void main (void)
{
int dist1[N];
int dist2[N];
int dist3[N];
memcpy (dist1, array, sizeof (int) * N);
quicksort (N, dist1);
memcpy (dist2, array, sizeof (int) * N);
bubblesort (N, dist2);
memcpy (dist3, array, sizeof (int) * N);
heapsort (N, dist3);
}
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• Quicksort: quicksort()
/* Quick Sort */
void qsort (int a[], int first, int last);
void quicksort (int n, int a[])
{
qsort (a, 0, n-1);
}
void qsort (int a[], int first, int last)
{
int i, j;
int pivot;
int tmp;
pivot = a[ (first + last) / 2];
i = first; j = last;
for (;;) {
while (a[i] < pivot) i++;
while (pivot < a[j]) j--;
if (i >= j) break;
tmp = a[i]; a[i] = a[j]; a[j] = tmp;
i++; j--;
}
if (first < i - 1) qsort (a, first , i - 1);
if (j + 1 < last) qsort (a, j + 1, last);
}

• Heapsort: heapsort()
/* Heap Sort */
void heapsort (int n, int a[])
{
int i, j, k;
int x;
for (k=n/2; k >= 1; k--) {
i = k; x = a[i];
while ( (j=2*i) <= n) {
if (j < n && a[j] < a[j + 1]) j++;
if (x >= a[j]) break;
a[i] = a[j]; i = j;
}
a[i] = x;
}
while (n > 1) {
x = a[n]; a[n] = a[1]; n--;
i = 1;
while ( (j=2*i) <= n) {
if (j < n && a[j] < a[j + 1]) j++;
if (x >= a[j]) break;
a[i] = a[j]; i = j;
}
a[i] = x;
}
}
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• Bubblesort: bubblesort()
/* Bubble Sort */
void bubblesort (int n, int a[])
{
int i, j, k;
int tmp;
k = n - 1;
while (k >= 0) {
j = -1;
for (i=1; i <= k; i++)
if (a[i - 1] > a[i]) {
j = i - 1;
tmp = a[j]; a[j] = a[i]; a[i] = tmp;
}
k = j;
}
}
(1)

Performance analysis functionality

In the Performance Analysis window, set the function to be measured. The measured functions are quicksort:
quicksort(), heapsort: heapsort(), bubblesort: bubblesort(), and qsort() as called from
quicksort(). For details about these settings, in 4.2 Usage, see (1) Performance analysis functionality.
When the program is executed, the measurement results are output to the Performance Analysis window.

Figure 4-7
Table 4-2 lists the cycle count for each sort from Figure 4-7.
Table 4-2 Measurement results for performance analysis functionality
Sort name
quicksort
heapsort
bubblesort
(2)

Functions
quicksort() +
qsort()
heapsort()
bubblesort()

Cycle count
10520
10784
44005

Profiler functionality

In the Profiling window, enable Include Data of Child Functions. For details about this setting, in 4.2 Usage, see (2)
Profiler functionality.
When the program is executed, the measurement results are output to the Profiling window.
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Figure 4-8
Table 4-3 lists the cycle count for each sort from Figure 4-8.
Table 4-3 Profiler functionality measurement results
Sort name
quicksort
heapsort
bubblesort
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5.

Pseudo-interrupts

The simulator window can be used manually to make an interrupt occur virtually. This allows interrupts that cannot be
made to occur, such as those from external devices, to be simulated as well. This chapter explains how to use
pseudo-interrupts.

5.1

Usage

To use a pseudo-interrupt, use the trigger button placed in the Trigger window. The following explains how to use the
trigger button to make a pseudo-interrupt occur. First, from CPU in the View menu, choose Trigger to display the
Trigger window. In the Trigger window, right-click to display the pop-up menu, and choose Setting from this menu to
display the Trigger Setting dialog box and set the trigger button.

Figure 5-1
In the Trigger Setting dialog box, set the contents of the interrupt to occur when the trigger button is clicked. Note that as
many as 256 settings can be performed for a button.

Figure 5-2
The following lists the contents set in the Trigger Setting dialog box:
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[Trigger No.]
[Enable]
[Name]
[Interrupt Type1]

[Interrupt Type2]
[Priority]

Selects the trigger button to be specified in detail
Checking this box enables the trigger button.
Specifies a name for the selected trigger button; the name will be displayed in the [Trigger]
window
Sets the following values for each CPU
• SH-1, SH-2, SH2-DSP, and SH2A-FPU series
Interrupt vector number
• SH-3, SH-4 and SH3-DSP series
INTEVT (H'0 to H'FFF)
• SH-4A series
INTEVT (H'0 to H'3FFF)
Only selectable for the SH3-DSP series: INTEVT2 (H'0 to H'FFF)
Interrupt priority (0 to 17)
When 16 is specified, the interrupt is always accepted regardless of the value of the I bit value
in SR, but is masked by the BL bit in SR. When 17 is specified, the interrupt is always accepted
regardless of the I and BL bit values in SR.

The Simulator System dialog box can be used to set whether the simulation stops or continues to be executed when an
interrupt occurs. From Simulator in the Setup menu, choose System to display the Simulator System dialog box. To
continue execution of the simulation, choose Continue from the Execution Mode drop-down list. To stop the simulation,
choose Stop from the Execution Mode drop-down list, and click the Detail button to display the Stoppage Setting dialog
box. In this dialog box, select the Interrupt Exception checkbox for Break cause.

Figure 5-3
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5.2

Sample program

The interrupt specification differs between the SH-1, SH-2, and SH-2A series, and the SH-3, SH-4, and SH-4A series, as
do the settings in the Trigger Setting dialog box. The following explains how to use pseudo-interrupts using the sample
programs for SH-2A and SH-4.

5.2.1

SH-2A

The following explains how to use a pseudo-interrupt in the SH-2A simulator. To receive interrupts in the sample
program, use set_imask() in the main function to set the interrupt mask to 0. This means that interrupts with a
priority level of 1 or higher are accepted. Then, once the interrupt mask is set, processing is only performed for infinite
loops. When an interrupt occurs, the function corresponding to the vector number registered in the interrupt vector table is
called.
#include <machine.h>
void main (void)
{
set_imask (0);
for (;;) {
nop();
}
}

For Interrupt Type1 in the Trigger Setting dialog box, specify the vector number in the interrupt vector table. In Figure
5-4, H’00000040 is specified as the vector number, with 5 specified as the interrupt priority. In the sample program, the
function corresponding to vector number H’00000040 is INT_IRQ0().

Figure 5-4
Use the Simulator System dialog box to set the simulation to stop when an interrupt occurs. For details about this setting,
see 5.1 Usage. Once the program is executed, click the trigger button set in the Trigger window.

Figure 5-5
When the trigger button is clicked, a virtual interrupt occurs, and INT_IRQ0(), the function corresponding to vector
number H’00000040, is called.
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Figure 5-6

5.2.2

SH-4

The following explains how to use pseudo-interrupts for the SH-4 simulator. To have the sample program receive
interrupts, use set_cr() in the power-on reset function PowerON_Reset() to set the interrupt mask to 0. This
means that interrupts with a priority level of 1 or higher are accepted. Then, once the interrupt mask is set, processing is
only performed for infinite loops. When an interrupt occurs, the exception processing handler _IRQHandler is called,
and the interrupt processing function corresponding to the INTEVT value in _IRQHandler is called.
#include
<machine.h>
.
.
.
#define SR_Init
0x00000000
.
.
.
void PowerON_Reset (void)
{
.
.
.
set_cr (SR_Init);
for (;;) {
nop();
}
.
.
.

For Interrupt Type1 in the Trigger Setting dialog box, specify the value of INTEVT. In Figure 5-7, H’00000200 is
specified as the value of INTEVT, and 4 is specified as the interrupt priority. In the sample program, when the value of
INTEVT is H’00000200, an attempt is made to call the interrupt processing function INT_Extern_0000() in
_IRQHandler.
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Figure 5-7
Use the Simulator System dialog box to set the simulation to stop when an interrupt occurs. For details about this setting,
see 5.1 Usage. Once the program is executed, click the trigger button set in the Trigger window.

Figure 5-8
When the trigger button is clicked, an interrupt occurs, and the simulation stops during an infinite loop. Here, step-in
(F11) can be performed to see that the exception processing handler _IRQHandler is called. Step-in can be repeated to
see that the value of INTEVT is H’00000200, and the corresponding interrupt processing function of
INT_Extern_0000() is called.
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Figure 5-9

REJ06J0045-0100/Rev.1.00

April.2008

Page 35 of 56

APPLICATION NOTE
6.

Timer simulation

Timer control is used in many embedded applications. The simulator allows timer functionality to be partially simulated,
allowing timer-based application debugging.
Note that the timers supported by the simulator differ depending on the CPU used. For details about the timers supported
by the simulator, see SuperHTM RISC engine Simulator/Debugger User’s Manual 2.9.2 Control Registers. For simulation
of functionality for which terminal I/O such as input capture is used, use a pseudo-interrupt (see 5. Pseudo-interrupts).
Note that the type and usage of device timers differ depending on the device used. For details about timers, see the
hardware documentation for the device used.

6.1

Usage

To simulate timer control in the simulator, the peripheral function simulation module for the timer used must be
registered. Note that if the register address of the device used differs from the default simulator settings, the register
address for the peripheral function simulation module needs to be changed. The following explains how to register the
peripheral function simulation module, and change the register address of the peripheral function simulation module.
(1)

Registering the peripheral function simulation module

The peripheral function simulation module can be registered from the Set Peripheral Function Simulation dialog box
displayed when the simulator starts up. From the Set Peripheral Function Simulation dialog box, select the checkbox of
the timer to be used, from the Peripheral Functions list.

Figure 6-1
The following explains the contents set in each item in the Set Peripheral Function Simulation dialog box.
[Peripheral Function]
Shows information on the peripheral function simulation modules.
[Module Name]
Names of peripheral functions to be simulated
[File Name]
Names of files holding peripheral function simulation modules
Check the checkbox under [Module Name] to register the corresponding peripheral function
simulation module and make it available.
[Enable All]
Enables all peripheral functions.
[Disable All]
Disables all peripheral functions.
[Detail…]
Opens the [Peripheral Module Configuration] dialog box, allowing you to view
information on the corresponding peripheral function, and change the address where it
starts and the interrupt-source information.
[Peripheral Clock Rate] The ratio between the peripheral clock and the internal clock (the number of cycles of
the internal clock corresponding to one cycle of the peripheral clock) is specified here.
The clock rate setting can be selected as 1, 2, 3, 4, 6, 8, 12, 16, 24, or 32.
When the Don’t show this dialog box checkbox is selected in the Set Peripheral Function Simulation dialog box, the Set
Peripheral Function Simulation dialog box is no longer displayed when the simulator starts up. To have it displayed again,
from the Setup menu, choose Options to display the Options dialog box, and then select the Confirmation tab. When the
Display Set Peripheral Function Simulation dialog box at start up checkbox is selected in the Display confirmation
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dialogs for list in the Confirmation tab, the Set Peripheral Function Simulation dialog box is displayed when the
simulator starts up.

Figure 6-2

(2)

Changing the address of the peripheral function simulation module

The register address of the peripheral function simulation module can be changed from the Peripheral Module
Configuration dialog box. In the Peripheral Function field in the Set Peripheral Function Simulation dialog box, select
the peripheral function for which the register address is to be changed, and then click the Detail button to display the
Peripheral Module Configuration dialog box. In the Peripheral Module Configuration dialog box, set the register address
of the device used in Begin Address (Register).
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Figure 6-3
The following items are displayed and set in the Address tab of the Peripheral Module Configuration dialog box.
[Module]

Name of the peripheral function supported by the selected peripheral function
simulation module
Start address of the peripheral function selected in [Module]
Names and addresses of registers of the peripheral function selected in [Module]. It is
not possible to change the register addresses.

[Begin Address(Register)]
[Register Address]

Note that interrupt cause information for peripheral functions can be viewed and changed in the Interrupt tab of the
Peripheral Module Configuration dialog box.

Double-clicking

[Interrupt Vector Number]
[Priority Register Address]
[Priority Register Size]
[Priority Register Bit Position]
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[Example of setting SH7085]

Begin Address (Register) : H’FFFFCE00

Interrupt Vector Number : 184
Priority Register Address : 0xFFFFE98E
Priority Register Bit Position : 15 - 12
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6.2

Sample program

The following explains how to use the sample program for timer simulation. In the sample program, interrupts based on a
compare match timer (CMT) are used to increment a variable at a fixed interval. The CMT is a timer for which an
interrupt occurs when the timer count and compare match value match.
The following gives a detailed explanation of the sample program. Note that the structure corresponding the register for
the interrupt controller (INTC) and CMT peripheral function module is defined in iodefine.h.
• main function
(1) The count variable for counting is initialized.
(2) set_imask() is used to set the interrupt mask to 0 so that interrupts can be received.
(3) The CMT interrupt priority is set.
(4) The CMT compare match value is set.
(5) CMT interrupt occurrence is permitted.
(6) The CMT timer count is started.
(7) An infinite loop occurs, and the CMT interrupt continues to be received.
#include <machine.h>
#include "iodefine.h"
unsigned int count;
void main (void)
{
count = 0;
set_imask (0);
INTC.IPR08.WORD
CMT0.CMCOR
CMT0.CMCSR.WORD
CMT.CMSTR.WORD

/* (1) */

=
=
=
=

0xF000;
0x0FFF;
0x0040;
0x01;

for (;;) {
nop();
}

/*
/*
/*
/*
/*

(2)
(3)
(4)
(5)
(6)

*/
*/
*/
*/
*/

/* (7) */

}

• Timer interrupt function
(1) The count variable for counting is incremented.
(2) Interrupt is permitted again, since timer interrupt occurrence is prohibited when the CMT timer count matches
the compare match value. Note that the CMT timer count returns to 0 when it matches the compare match value,
and that incrementing is restarted.
// 140 CMT CMI0
#include "iodefine.h"
extern unsigned int count;
void INT_CMT_CMI0 (void){
count++;
/* (1) */
CMT0.CMCSR.WORD = 0x0040; /* (2) */
}
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When starting the simulator, register the peripheral function simulation module in the Set Peripheral Function Simulation
dialog box. For details about registration, see 6.1 Usage.
Check the Watch window for the value of the count variable during program execution. From Symbol in the View
menu, choose Watch to display the Watch window. In the Watch window, register the symbol for the count variable,
and then enable auto-update for the registered count symbol. When the sample program is executed, the count
variable is incremented in the Watch window (Figure 6-4). This reflects the fact that timer interrupts are occurring
regularly.

Figure 6-4

REJ06J0045-0100/Rev.1.00

April.2008

Page 41 of 56

APPLICATION NOTE
7.

Eventpoints

Breakpoints (software breakpoints) set from the editor window stop execution of user programs immediately before the
instruction at the set address is executed. In contrast, eventpoints can be set to provide more advanced program stop
conditions than software breakpoints. For example, breakpoints can be set to stop a program when conditions such as the
following are satisfied:
(1) The value of a certain register or piece of data reaches a specified value
(2) The specified data area is accessed
(3) The execution cycle count reaches the specified cycle count
Note that for an eventpoint, instead of stopping the program when a set condition is satisfied, data can be written from a
file to memory or from memory to a file, and an interrupt can occur.

7.1

Usage

Eventpoints can be set by choosing Eventpoints from Code in the View menu, to display the Eventpoints window.
Right-click in the Eventpoints window to display a pop-up menu, and then choose Add to display the Select Break Type
dialog box. In the Select Break Type dialog box, set the conditions for stopping user programs, and the operations
performed when conditions are satisfied. When settings are completed, if Stop is specified for Action type, the contents
of the set eventpoint are displayed in the Software Break tab of the Eventpoints window. If anything other than Stop is
specified, the contents of the set eventpoint are displayed in the Software Event tab of the Eventpoints window. For
details about the items that can be set for eventpoints, see SuperHTM RISC engine Simulator/Debugger User’s Manual 3.4 Using the Simulator/Debugger Breakpoints.

Figure 7-1
The following lists the information displayed in the Eventpoints window:
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[Type] Break types
[BP]:
PC break
[BA]:
Access break
[BD]:
Data break
[BR]:
Register break (register name)
[BS]:
Sequential break
[BCY]:
Number-of cycles break
[State] Whether the breakpoint is enabled or disabled.
[Enable]:
Valid
[Disable]:
Invalid
[Condition] Condition that causes a break. The contents to be displayed depend on the type of the break. When the
type of the break is BR, the register name is displayed, and when the type of the break is BCY, the
number of cycles is displayed.
BP:
PC = Program counter (Corresponding file name, line, and symbol name)
BA:
Address=Address (Symbol name)
BD:
Address=Address (Symbol name)
BR:
Register=Register name
BS:
PC = Program counter (Corresponding file name, line, and symbol name)
BCY:
Cycle = Number of cycles (displayed in hexadecimal)
[Action] Operation of the simulator/debugger when a break condition is satisfied.
[Stop]:
Execution halts
[File Input]:
(file name) [File state]: Memory data is read from file
[File Output]: (file name) [File state]: Memory data is written to file
[Interrupt]:
(Interrupt type/priority): Interrupt processing.
Only for the SH3-DSP, (Interrupt type 1, interrupt type 2/priority) is displayed.

7.2

Sample program

The following explains how to use the sample program for using eventpoint break data. In the sample program, the global
variable x is incremented in a loop. This program is used as an example in which the program is stopped when the global
variable x reaches a specific value.
The sample program is as follows:
volatile long x;
void main (void)
{
int i;
x = 0;
for (i=0; i < 10000; i++ ) {
x++;
}
}

The following explains how to stop a program when the value of the global variable x reaches 5000. First, from the Select
Break Type dialog box, choose break data for Break type, and then click the Detail button to display the Set Data Break
Condition dialog box. Then, set the items in the Set Data Break Condition dialog box as follows:
•
•
•
•
•

Address:
Option:
Data:
Data mask:
Size:

_x
Equal
D’5000
Cleared
Long word
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Figure 7-2
The set eventpoint is displayed in the Eventpoints window.

Figure 7-3
When the sample program is executed, it is stopped immediately after the value of the variable x reaches 5000.

Figure 7-4
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8.

Virtual I/O panels

Virtual I/O panels can be used to check data visually, by placing virtual buttons and LEDs on the simulator window.
Virtual I/O panels can use the following GUI components:
• Buttons
Buttons can be clicked to input data to the specified address, or make a virtual interrupt occur.
• Labels
Specific strings can be displayed and removed when specified values are written to a specified address or bit.
• LEDs
Specified colors can be displayed (in place of an LED light) when specified values are written to a specified address or
bit.
• Text
Specified strings are always displayed.

8.1

Usage

Virtualized output panels are used by being placed in the GUI I/O window. The following explains how to set up a panel.
From Graphic in the View menu, choose GUI I/O to display the GUI I/O window. To place the panel, right-click in the
GUI I/O window to display a pop-up menu, and then choose the item for the panel to be created. The mouse cursor will
change to a plus sign (+), at which point the panel to be created can be dragged between from the upper left to the lower
right to create an output frame. As output frames are selected once they are created, the created output frame can be
double-clicked to display a dialog box for setting the panel display contents.

Drag from upper left to lower right

Double-click the target

Figure 8-1
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The panel settings for the GUI I/O window are saved independently of the workspace, which means that they need to be
saved to a file separate from the workspace and project. To save panel settings, from the pop-up menu, choose Save to
display the Save GUI I/O Panel File dialog box. In the Save GUI I/O Panel File dialog box, specify the save destination
file name, whose extension is .pnl by default. To load a file to which panel settings have been saved, from the pop-up
menu in the GUI I/O window, choose Load, and then select the saved file.

8.1.1

Button display

To create a button panel, from the pop-up menu, choose Create Button. Once the button output frame is created, select
the output frame, and double-click to display the Set Button Dialog dialog box.

Figure 8-2
Perform the following settings in the Set Button Dialog dialog box.
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Button Name
Specify the name displayed in the button panel.
Select Button Type
Select Input, Interrupt, or Input and Interrupt.
Input: specify the following when Input or Input and Interrupt is selected for Select Button Type:
Type
Select Address to change the specified address to a specific value, or Address & Bit No. to
specify a bit position and change the value of the specified address, when the button panel
is clicked.
Address
Specify the address for changing the value when the button panel is clicked.
Data
Specify the value to replace the specified address when the button panel is clicked. Specify
this if Address is selected for Type, or Address & Bit No. is selected and a bitwise mask is
used.
Length
Specify the size of the data.
Bit Mask
Set the following when Address & Bit No. is set for Type:
When not using a bitwise mask, clear the Not use checkbox, and set Bit No. To use a
bitwise mask, set Mask Data.
Mask Data Change the value of the specified address to the bits of the value specified for the data,
only where the bit for the specified mask value is 1.
Bit No
For bits 7 to 0, specify 0, 1, or -.
Specify 0 for bits whose value is to be set to 0.
Specify 1 for bits whose value is to be set to 1.
Specify - for bits whose value is to be unchanged.
Bit Symbol and Bit Value cannot be input for SH microcomputer simulators.
Interrupt
Specify this when Interrupt or Input and Interrupt is selected for Select Button Type.
[Interrupt Type1]
Sets the following values for each CPU
• SH-1, SH-2, SH2-DSP, and SH2A-FPU series
Interrupt vector number
• SH-3, SH-4 and SH3-DSP series
INTEVT (H'0 to H'FFF)
• SH-4A series
INTEVT (H'0 to H'3FFF)
[Interrupt Type2]
Only selectable for the SH3-DSP series: INTEVT2 (H'0 to H'FFF)
[Priority]
Interrupt priority (0 to 17)
When 16 is specified, the interrupt is always accepted regardless of
the value of the I bit value in SR, but is masked by the BL bit in SR.
When 17 is specified, the interrupt is always accepted regardless of
the I and BL bit values in SR.

8.1.2

Label display

To create a label panel, from the pop-up menu, choose Create Label. Once the label output frame is created, select the
output frame, and double-click to display the Set Label Dialog dialog box.
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Figure 8-3
Perform the following settings in the Set Label Dialog dialog box:
(1)

When the Bit radio button is selected for Bit Or Data:
Address
Bit Num
Name1
Name2
Logic

(2)

Set the start address for byte data.
Set the bit position (0 to 7) from the LSB in the byte data.
Set the string to be displayed.
Set the string to be displayed.
The label panel is displayed as follows:
If the Positive radio button is selected, Name1 is displayed when the set bit is 1, and Name2 is
displayed when the set bit is 0.
If the Negative radio button is selected, Name2 is displayed when the set bit is 1, and Name1 is
displayed when the set bit is 0.
When the Data radio button is selected for Bit Or Data:
Address
Name1
Name2
Data

8.1.3

Set the start address for byte data.
Set the string to be displayed.
Set the string to be displayed.
The label panel is displayed as follows:
Name1 is displayed if the data specified in Address is the value set for Display Name1, and
Name2 is displayed if the data specified in Address is the value set for Display Name2. Note
that no string is displayed for values other than those set for Display Name1 and Display
Name2.

LED display

To create an LED panel, from the pop-up menu, select Create LED. Once the LED output frame is created, select the
output frame and double-click to display the Set LED Dialog dialog box.
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Figure 8-4
Perform the following settings in the Set LED Dialog dialog box:
(1)

When the Bit radio button is selected for Bit Or Data:
Address
Bit Num
Color1
Color2
Logic

(2)

Set the start address for byte data.
Set the bit position (0 to 7) from the LSB in the byte data.
Select the color to be displayed.
Select the color to be displayed.
The label panel is displayed as follows:
If the Positive radio button is selected, Color1 is displayed when the set bit is 1, and Color2 is
displayed when the set bit is 0.
If the Negative radio button is selected, Color2 is displayed when the set bit is 1, and Color1 is
displayed when the set bit is 0.
When the Data radio button is selected for Bit Or Data:
Address
Color1
Color2
Data

8.1.4

Set the start address for byte data.
Select the color to be displayed.
Select the color to be displayed.
The label panel is displayed as follows:
Color1 is displayed if the data specified in Address is the value set for Display Color1, and
Color2 is displayed if the data specified in Address is the value set for Display Color2. Note that
nothing is displayed for values other than those set for Display Color1 and Display Color2.

Text display

To create a text panel, from the pop-up menu, choose Create Text. Once the text output frame is created, select the output
frame, and then double-click to display the Set Text Dialog dialog box.
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Figure 8-5
Perform the following settings in the Set Text Dialog dialog box:
Text
Font
Color

8.2

Set the string to be displayed in the text panel.
Click the Font button to set the font and font size of the string displayed.
Click the Text button to set the color of the string displayed. Click the Back button to set the
background color of the text panel.

Sample program

The following uses a sample program to explain how to use virtual I/O panels.
The virtual I/O panel for the sample program contains an LED panel that is lit based on the value of a given variable, and
a button panel to change the value of the variable. The sample program shows an example in which the value of a variable
is changed by the button panel, and the results are indicated by a lit LED panel. Note that in the sample program, using
flashing LEDs for variable access implies I/O port access. On actual hardware, I/O port initialization processing is
required when displaying LEDs or performing input from buttons.
The sample program is as follows. The main function performs only an infinite loop.
#include <machine.h>
volatile unsigned char port;
void main (void)
{
Port = 0;
for (;;) {
nop();
}
}

Place the output frame of the virtual I/O panel as follows in the GUI I/O window. Place an LED panel and label panel for
which the display changes according to the second bit in the variable port. Also place a button panel that changes the
second bit of the variable port to 0, and a button panel that changes the second bit of the variable port to 1.
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(A) Button panel for setting the second bit to 0.

Text panel

LED panel

Label panel

(B) Button panel for setting the second bit to 1.

Figure 8-6
Set the contents of each panel as follows.
• Text panel
Create a text panel to display the string L2.

Figure 8-7
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• LED panel
Create an LED panel that changes color based on the value of the second bit of the variable port. Specify 1 for Bit
Num, and set positive logic for Logic.

Figure 8-8
• Label panel
Create a label panel that changes its displayed string based on the value of the second bit in the variable port.
Specify 1 for Bit Num, and set positive logic for Logic.

Figure 8-9
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• Button panel
Create the following button panels for setting the data in the variable port:
• (A) A button panel that sets the second bit of the variable port to 0.
• (B) A button panel that sets the second bit of the variable port to 1.
(A)

(B)

Figure 8-10
To prevent the GUI I/O window from updating during program execution, execute cache off in the Command window
(Figure 8-11). To display the Command window, choose Command Line from the View menu.

Figure 8-11
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Click the (B) button panel during program execution to set the second bit of the variable port to 1. This will cause the
color of the LED panel to change from black to red. Likewise, the string in the label panel will change from OFF to ON.

Click button panel (B)

Figure 8-12
Click the (A) button panel during program execution to set the second bit of the variable port to 0. This will cause the
color of the LED panel to change from red to black. Likewise, the string in the label panel will change from ON to OFF.

Click button panel (A)
129

Figure 8-13
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Notes regarding these materials
1.

2.
3.

4.

5.
6.

7.

8.

9.

10.

11.

12.
13.

This document is provided for reference purposes only so that Renesas customers may select the appropriate
Renesas products for their use. Renesas neither makes warranties or representations with respect to the
accuracy or completeness of the information contained in this document nor grants any license to any intellectual
property rights or any other rights of Renesas or any third party with respect to the information in this document.
Renesas shall have no liability for damages or infringement of any intellectual property or other rights arising out
of the use of any information in this document, including, but not limited to, product data, diagrams, charts,
programs, algorithms, and application circuit examples.
You should not use the products or the technology described in this document for the purpose of military
applications such as the development of weapons of mass destruction or for the purpose of any other military
use. When exporting the products or technology described herein, you should follow the applicable export
control laws and regulations, and procedures required by such laws and regulations.
All information included in this document such as product data, diagrams, charts, programs, algorithms, and
application circuit examples, is current as of the date this document is issued. Such information, however, is
subject to change without any prior notice. Before purchasing or using any Renesas products listed in this
document, please confirm the latest product information with a Renesas sales office. Also, please pay regular
and careful attention to additional and different information to be disclosed by Renesas such as that disclosed
through our website. (http://www.renesas.com)
Renesas has used reasonable care in compiling the information included in this document, but Renesas
assumes no liability whatsoever for any damages incurred as a result of errors or omissions in the information
included in this document.
When using or otherwise relying on the information in this document, you should evaluate the information in light
of the total system before deciding about the applicability of such information to the intended application.
Renesas makes no representations, warranties or guaranties regarding the suitability of its products for any
particular application and specifically disclaims any liability arising out of the application and use of the
information in this document or Renesas products.
With the exception of products specified by Renesas as suitable for automobile applications, Renesas products
are not designed, manufactured or tested for applications or otherwise in systems the failure or malfunction of
which may cause a direct threat to human life or create a risk of human injury or which require especially high
quality and reliability such as safety systems, or equipment or systems for transportation and traffic, healthcare,
combustion control, aerospace and aeronautics, nuclear power, or undersea communication transmission. If you
are considering the use of our products for such purposes, please contact a Renesas sales office beforehand.
Renesas shall have no liability for damages arising out of the uses set forth above.
Notwithstanding the preceding paragraph, you should not use Renesas products for the purposes listed below:
(1) artificial life support devices or systems
(2) surgical implantations
(3) healthcare intervention (e.g., excision, administration of medication, etc.)
(4) any other purposes that pose a direct threat to human life
Renesas shall have no liability for damages arising out of the uses set forth in the above and purchasers who
elect to use Renesas products in any of the foregoing applications shall indemnify and hold harmless Renesas
Technology Corp., its affiliated companies and their officers, directors, and employees against any and all
damages arising out of such applications.
You should use the products described herein within the range specified by Renesas, especially with respect to
the maximum rating, operating supply voltage range, movement power voltage range, heat radiation
characteristics, installation and other product characteristics. Renesas shall have no liability for malfunctions or
damages arising out of the use of Renesas products beyond such specified ranges.
Although Renesas endeavors to improve the quality and reliability of its products, IC products have specific
characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions.
Please be sure to implement safety measures to guard against the possibility of physical injury, and injury or
damage caused by fire in the event of the failure of a Renesas product, such as safety design for hardware and
software including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment
for aging degradation or any other applicable measures. Among others, since the evaluation of microcomputer
software alone is very difficult, please evaluate the safety of the final products or system manufactured by you.
In case Renesas products listed in this document are detached from the products to which the Renesas products
are attached or affixed, the risk of accident such as swallowing by infants and small children is very high. You
should implement safety measures so that Renesas products may not be easily detached from your products.
Renesas shall have no liability for damages arising out of such detachment.
This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written
approval from Renesas.
Please contact a Renesas sales office if you have any questions regarding the information contained in this
document, Renesas semiconductor products, or if you have any other inquiries.
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